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DISCLAIMER 
  
Please be aware of the loss, risk, personal or otherwise consequences of the use 
and application of this book‘s content. The author and the publisher are not 
responsible for any actions that you undertake and will not be held accountable 
for any loss or injuries.  
  

U.S. Government Required Disclaimer  - Commodity Futures Trading  
Commission Futures and Options trading has large potential rewards, but also 
large potential risks. You must be aware of the risks and be willing to accept them 
in order to invest in the futures and options markets. Don't trade with money you 
can't afford to lose. This is neither a solicitation nor an offer to Buy/Sell futures or 
options. No representation is being made that any account will or is likely to 
achieve profits or losses similar to those discussed on this website. The past 
performance of any trading software or methodology is not necessarily indicative 
of future results.  
  

CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE 
RESULTS HAVE CERTAIN LIMITATIONS. UNLIKE AN ACTUAL 
PERFORMANCE RECORD, SIMULATED RESULTS DO NOT REPRESENT 
ACTUAL TRADING. ALSO, SINCE THE TRADES HAVE NOT BEEN EXECUTED, 
THE RESULTS MAY HAVE UNDER-OR-OVER COMPENSATED FOR THE 
IMPACT, IF ANY, OF CERTAIN MARKET FACTORS, SUCH AS LACK OF 
LIQUIDITY. SIMULATED TRADING PROGRAMS IN GENERAL ARE ALSO 
SUBJECT TO THE FACT THAT THEY ARE DESIGNED WITH THE BENEFIT OF 
HINDSIGHT. NO REPRESENTATION IS BEING MADE THAT ANY ACCOUNT 
WILL OR IS LIKELY TO ACHIEVE PROFIT OR LOSSES SIMILAR TO THOSE 
SHOWN.  
  

No representation is being made that any account will or is likely to achieve 
profits or losses similar to those shown. In fact, there are frequently sharp 
differences between hypothetical performance results and the actual results 
subsequently achieved by any particular trading program. Hypothetical trading 
does not involve financial risk, and no hypothetical trading record can completely 
account for the impact of financial risk in actual trading. All information on this 
website or any ebook purchased from this website is for educational purposes 
only and is not intended to provide financial advice. Any statements about profits 
or income, expressed or implied, do not represent a guarantee. Your actual 
trading may result in losses as no trading software is guaranteed. You accept full 
responsibilities for your actions, trades, profit or loss, and agree to hold Fibo 
Machine Pro and any authorized distributors of this information harmless in any 
and all ways. The use of this software constitutes acceptance of this user 
agreement. 
 

 



COPYRIGHT  
  

This book and software cannot be re-written, re-published, STORED OR 
LINKED AT ANY FILE SHARING SITES or FORUMS or used for any other 
books without proper referencing without permission. The use of the book and 
software is limited to your personal use only. Spreading out the copies without 
the agreement of the development team is illegal and protected by international 
copyright law.  
  

Copyright © 2016 www.FiboMachinePro.com  
  

Introduction  
  

Thank you for your purchase of “Fibo Machine Pro”!  

  

Fibo Machine Pro software package includes:  
  

- Step-by-step users guide   
  

- Indicator‘s secret trading algorithm explained in detail   
  

- Fibo Machine Pro indicator software itself   
  

- Live Actions Screenshots   
  

- Sample Trades examples   
  

- Personal "I will help you" promise from the developer  
  

  

Fibo Machine Pro is a special brand new indicator. It uses unique Fibonacci levels 
in a very smart way. What you will see when you attach this indicator to your chart 
are colorful levels, different for each day. These levels will show you entry level, 
stop loss level and 3 take profit levels. You can choose between any of them, 
depending on the style of your trading. On top of all this, this new indicator is also 
equipped with highly customizable signal alerts system and an option to change 
the color of the signal lines.  

  

It's extremely important for you to fully understand how Fibo Machine Pro 
works. Read this guide carefully, it has a lot of important information that 

could greatly improve your trading experience.  
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What or Who is Fibonacci?  
 
Fibonacci trading has become very popular amongst Forex traders in recent 
years. Nevertheless, have you ever wondered where such a technique came from? 
The trading technique of Fibonacci came from an Italian mathematician who 
lived back in the thirteenth century in Italy. His name was Leonardo Fibonacci.  
  

  

Fibonacci expanded his studies back in 
the thirteenth century and led to create 
today‘s understanding of the Fibonacci 
technique.  

What did he discover?   

Fibonacci went on to discover a specific 
number sequence that was applied to 
natural proportions of matter- nature 
and the universe.  
The Fibonacci number sequence  

1, 2, 3, 5, 8, 13, 21… …  

Each number in this Fibonacci 
number sequence is found simply by 
adding the two previous numbers 

together. For instance, 2+ 3= 5 and 5 + 8=13.  
  

  

Fibonacci continued his mathematical studies and expanded his number 
sequence to discover the ‗Golden Ratio‘ as known today in the Forex market. The 
‗Golden Ratio‘ was determined by dividing any number after 3 by the next 
consecutive number. The answer would be 62.5. As you go higher up in the 
number sequence and perform the same calculation, the resulting ratio would be 
61.8%. This 61.8% is identified as the ‗Golden Number‘.  

Although Leonardo Fibonacci was not the first person to recognize such 
repeating patterns and ratios of the universe, his study of the number sequence 
is what is so famously known today in the Forex industry.  
  
NOTE: Please try using the indicator on a demo account first. Only move to 
trading with it on a live account, once you are completely familiar with Fibo 
Machine Pro and fully understand all the simple rules on how to use it correctly.  

Do not hesitate to contact us if you have any questions!  
  



We wish you a great success!  

Karl Dittmann’s  Trading Team 
 
www.FiboMachinePro.com 

 

Installing the Indicator 
 

IMPORTANT: Make sure to update your MT4 to the latest build. Fibo 
Machine Pro is designed to give you best results and to work properly only with 
the latest version of MT4 platform.  
  

  
    

Unzip the zip file that you have downloaded:   

  

1) The indicator file is FiboMachinePro.ex4  

  

MT4 installation instructions:  

  

Step 1:  

  

1) Open your MT4 platform   

  

2) Click File — Open Data Folder. Here you will find a folder called MQL4.  
  

3) Open folder MQL4. Here you will find Indicators folder. Copy your Indicator 
(ex4) file into MQL4/Indicators folder. Do this by right clicking on the file and 
clicking ―> copy and then ―>paste.   

 

4) Restart your MT4.  
  
If you have any difficulties, please write me an email 
and I will help you as soon as possible.  
  
My email is: karl@karldittmann.com  
  

  

  

 

 

 

  



Step 2: Open the MetaTrader® platform, and 
click on View -> Navigator.  
  
   

You can also press 
CTRL+N.  
  

  

  

  

  

  

  

Click on 'Navigator'  

  

  

Step 3: A window titled 'Navigator' will 
appear. Double click on Indicators.  
  

  

  

  

  

  

 
Step 4: You should see the FiboMachinePro in the Indicators folder. Double click on 

the FiboMachinePro file and click OK to load it onto your chart.  
  

Step 5: Once you attach Fibo Machine Pro, make sure to enable the two options as shown 

below and only then click OK.  
  

  



Need Help? Please contact me at: 

karl@karldittmann.com  
  

  

Informer  

  

Fibo Machine Pro has been enhanced with a new smart informer system, which is 
designed to make your trading more pleasant, convenient and profitable.  
  

The informer shows the indicator name, 
currency pair and timeframe, entry and stop 
loss levels, 3 different take profit levels (will be 
explained in the guide), current trend direction, 
trend power, time until next candle and current 
time.  
  

  

  

  

  

  

  

  

  

  

  

MUST READ RULES on how to use the signals  
   

Important Rule #1:  

  

Do not use the indicator on a flat market! Use the indicator ONLY at 
active market hours – for example London session, US session.  

  

Trend will not be noticeable on a weak market (night time, Christmas period,   

other holidays etc…) keep reading and I will explain everything...  
  

Important Rule #2:  

  

- Identify a global trend. (Remember? Trend is your friend?)   
- Ignore all signals against a current GLOBAL trend!   
- Try using the informer to find out how strong the current trend is.   

  



Example:  

  

Global trend is up – but you get a ―sell‖ signal 
(It‘s better to ignore it and wait for a ―buy‖ 
signal to enter)  
  

This is the most important rule, if you follow it you 
will have almost no losing trades at all.  
  

Often signals that are against the global trend 
win as well. However, entering these trades 
might be more risky, than trading with the 
direction of the trend.  
Important Rule #3:  

  

The next highly important rule: Do not trade and do not use the 
indicator on a sideways trend. This is a ―MUST follow‖ rule.  
  

If you DON‘T follow or ignore the rules above – good results are NOT 
guaranteed!  
  

  

Stop Loss  

  

Place your stop loss according to the popup alert SL. It is also shown in the 
informer.  
   

  

IMPORTANT: Set stop loss for ALL your trades and DO NOT deviate from it. Once 
the trade has touched your stop loss, be disciplined and close the trade. This will 
protect you from major capital losses.  
  

  

  

  

  

  

  

  

  

  

  

  



Entering Trades  

  

  
Buy when the signal price crosses the 
aqua Entry Level (BUY) from 
bottom to top. (As shown on the 
screenshot to your left)  

  

  

  

  

  

  

  

  

  

  

  

  

   

  

  

 

Sell when the signal price 
crosses the salmon color  
Entry Level (SELL) from 
top to bottom. (As shown on  
the screenshot to your right)   
  

  

  

  

  

  

  

  

  

  

  

  

  

  

  



Exiting Trades  

  

Option 1  

  

Exit your trades when the price reaches one of the three Take Profit 
Levels. You can choose any of the Levels depending on your proffered 
trading style. This will ensure that you trade with maximum profit for 
your style.  
  

If you enter with BUY   
(Aqua Entry Level (BUY) crossed from bottom to top)  
  

-exit as soon as the price reaches: Safe Take Profit Level (BUY),   
                                                             Medium Take Profit Level (BUY)  

                                                   OR   Aggressive Take Profit Level (BUY)  

  

If you enter with SELL   
(Salmon Entry Level (SELL) crossed from bottom to top)  
  

-exit as soon as the price reaches: Safe Take Profit Level (SELL),   
                                                             Medium Take Profit Level (SELL)  

                                                   OR   Aggressive Take Profit Level (SELL)  

  

Option 2  

  

You can also exit according to the Take Profit (TP) level that is shown in the 
popup alert window. The alerts will show the same Take Profit Levels as you see 
on the chart. It very convenient since the alerts alarm you when the price reaches 
the desired Take Profit Level.  
  

You can easily configure the alerts system to alarm when the price reaches a 
specific Take Profit Level of your choice or whenever the price reaches any of them.  
  

Option 3  

  

Another exit mechanism which is highly effective is to exit near strong support or 
resistance levels. It is a method that generates exits earlier, however you can just 
go for Safe Take Profit Levels instead.   
 

 

 

 

 



Time Frames and Pairs  

  

-M15, M30, H1 and H4 only. H1 recommended  
  

-Works on all major pairs. EUR/USD, GBP/USD, EUR/JPY, GBP/JPY 
recommended.  
  
   
Signal Popup Alert Window:  

  

 
  

  

EURUSD, M30 – pair, timeframe  
BUY/SELL @ Price – entry price  
TP – Take Profit  
SL - Stop Loss  
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



Input Parameters:  

  

  

  

  

  

  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

All the Inputs are ready to use/trade by default.    
You don’t have to change anything.  

   

TakeProfit_Alert is the most important parameter. 
It‘s set to "ALERT_TAKE_ALL" by default.  
  

  
  

There are several modes for TakeProfit_Alert. Each mode corresponds to 
specific take profit levels alerts.   
  

For example:  
  

1) If you choose ALERT_TAKE_ALL - you will be alerted whenever any of the 3 
take profit levels is reached (safe, medium and aggressive).  



2) If you choose ALERT_TAKE_MEDIUM - you will be alerted only when 
medium take profit level is reached. The alerts will not inform you when safe or 
aggressive take profit level is reached.  

  

3) If you choose ALERT_TAKE_SAFE_and_AGGRESSIVE - you will be  
alerted only when safe or aggressive take profit level is reached. The alerts will not 
inform you when medium take profit level is reached.  
  

Hope this gives you the picture and you understand how the remaining modes 
work. If not, please write me an email to karl@karldittmann.com and I will 
help.  
  

These modes are made so that you can select the take profit alerts you want, 
without being interrupted by those that don't suit your trading style.  
  

  

The next input parameter is ShowLevelsDescription  
  

  
  

It is responsible for the description of the levels (Level Names) shown on your 
chart.  
You can choose not to show the description of the levels by selecting   
DONT _SHOW, show description only of the last day - SHOW_ONE_DAY, 
show description only on last two days - SHOW_TWO_DAYS or show 
description for all days - SHOW_ALL_DAYS (Default)  
LevelsDescriptionPosition parameter.  

  

This one simply allows you to choose whether you want the Level Names to be 
shown above or below (and also left middle or right) the actual Levels.  
  



  
  

  

  

The next parameter is InfoCorner, which is responsible for moving the informer 
in any of the corners of your trading chart. It's useful to change this input when the 
info box is coming on top of the price and makes the signals hardly visible.  
  

Info TextColor Allows you to change the font color of the informer.  
  

Left upper – Upper Left Corner  
Right upper – Upper Right Corner  
Left lower – Bottom Left Corner  
Right lower – Bottom Right Corner  
  

Tip: If you want to remove the informer from the current chart, just set the corner 
value to Don't show info. To put it back on, use any other value.  
  

  

PushNotification is responsible for sending push notifications with all details 
about every signal to your mobile device. Push notification is set to "false" by 
default. This option can be turned on by selecting "true".  
  

If you wish you may change the sound (SoundAlert) and email (EmailAlert) 
alerts to true/false. By default, sound alert is set to "true" and email alert to "false"  
  

Other inputs allow you to change color and width of the signal levels.  
  

Please continue reading to learn how to configure email alert and push notification.  
  

  

  

  

  

  



  

  

  

  
Most Profitable Recommended Products  

ever created by Karl Dittmann: Click here 

to view Recommended Products List!  

  
Best forex software, strategies, scalpers and intraday 

indicators that will help you make great profit 
everyday with no trading experience!  

  
I guarantee you will find 
something you will love! 

  
/Karl Dittmann/  
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EMAIL alert setup:  

  

Setup your metatrader4 to send email:  
  

 
  

Email alert must be activated in the Fibo Machine Pro 
INPUTS. After it‘s activated, all you have to do is setup 
your own mail server info…  
  

Email setup can be done in: Tools => Options => Email  

  

If you need more info on how to setup an email alert, go to youtube.com and search 
for ‖mt4 email setup‖ there are plenty of free explanation videos. 



Push Notification Setup:  

  

Push notifications will be sent to your mobile device via MT4 app and they will 
include all the information about every signal generated by Fibo Machine Pro.  
  

  
  

To set up push notifications, please follow these steps:  
  

1) Download and install MetaTrader 4 application from appstore or google play 
depending on the device you are using.  
  

2) Open the MetaTrader 4 application on your device. Go to Settings and look 
for MetaQuotes ID. It's a combination of numbers and letters. Write this as we are 
going to need it.  
  

3) Open MetaTrader 4 on your computer and go to Tools->Options-> 
Notifications. Enable "Enable Push Notifications", enter your MetaQuotes ID and 
click OK.  
  

4) Done! Attach Fibo Machine Pro to a chart of your choice and enjoy push 
notifications sent directly to your mobile device!  
  



Please note: For push notifications to work, Fibo Machine Pro must be attached 
to a chart, Push Alert in the indicator inputs must be set to "true", your computer 
and mobile device must be connected to the internet.  
  

Recommendations  

  

Use the indicator ONLY during ACTIVE market hours!  

 
Do not use the indicator on a weak/slow market – outside 

recommended trading hours (London or US sessions). 

Signals never work well on a weak market; this has been 

proven many times…  

  

The London session is the largest 
market and it opens at 08:00 GMT or 
03:00 EST and closes at 17:00 GMT or 
12:00 EST.  
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Trading is best between 08:00 GMT and 10:00 GMT  

The New York session opens at 13:00 GMT or 08:00 
EST and closes at 22:00 GMT or 17:00 EST.  

The best trades occur in the first 2-3 hours.  

The time is shown in 24:00 format.  
IMPORTANT:  It is extremely important to trade only following the current trend!   

It will cut ALL bad trades! Avoid trading against trend at all times.  

  

Look at the informer and see if it shows Current Trend: Up or Down.   

Enter with BUY if it shows Up or with SELL if it shows Down.  
  

Stay away from using the signals when you see unclear trend, flat or 
sideways trends – example:  
  

  
  

  

  

  

  

  

Money Management  

  

Money management is a very important concept that has an enormous effect on 
draw downs and margin calls. The cardinal rule of money management is the 
following:  
  

You should only risk 1-3% of your account on any single trade.  

  

You may have heard this rule a hundred times before, but it is amazing to see how 
many good traders fail to comprehend this concept – and don't understand why 
they are wiped out again and again, despite great entries and timing of trades.  



Another important concept that is related to your  stoploss:  
In this strategy you learned how to place a stop loss for each setup.  
  

This stop loss is calculated regardless of your level of risk or your equity,   and 
is based solely on price-action. After a stop loss is set, calculate your trade size 
so you achieve the right percent of risk for your trades.  

  
For example: your stop loss is 10 pips, and your equity is 10,000$, you wish to 
risk 2% of your equity in this trade, so you enter a trade with 2 lots – so your 
risk is 200$, or 2%.  
 
Another Actual trade example:  

 



  

  

Please contact me if you have any questions: 
karl@karldittmann.com 

 
I will do my best to help you with anything.  
 
Best of Luck! 
Karl Dittmann  

  
Most Profitable Recommended Products  

ever created by Karl Dittmann: Click here 

to view Recommended Products List!  

  
Best forex software, strategies, scalpers and 

intraday indicators that will help you make great 
profit everyday with no trading experience!  

  
I guarantee you will find  
something you will love! 

  
/Karl Dittmann/  
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